
Track the motion of an
object under specific 

simulation parameters

Use automatic collision
detection and friction to
accurately model real-life
mechanical systems

Record and display 
simulation data in real-
time

W o r k i n g  M o d e l ® 2 D

The world’s most popular 2D computer aided engineering tool

•• Powerful physics-based 2D kinematic and dynamic

motion simulation and analysis

•• Provides accurate solutions to complex engineering

motion simulation problems

•• Save time and money by avoiding expensive

prototyping and product failures

www.workingmodel.com



SUPPORTED 2D FORMAT

DXF file format

BODY PROPERTIES & FEATURES

• Body types: circle, box, polygon and 
smooth (b-Spline edges)

• Mass, density, geometry, center of mass, 
moment of inertia, velocity and angular 
velocity, electrostatic charge and more

• Track the motion path of a body

• Automatic collision detection and response

• Automatically applied static and kinetic 
friction 

CONSTRAINTS

• Pin, rigid, slot, keyed slot and curved 
slot joints

• Rods, ropes, pulleys and gears

• Linear and rotational spring/damper 

MOTION DRIVERS

• Motor

• Actuator

• Force

• Torque

Constraints and drivers can be defined by
numeric or equation input in the formula
editor, or with tabular data.

UNITS SYSTEMS & FORMULAS

SI, English, CGS and user-defined

MEASURABLE PARAMETERS

• Position

• Velocity

• Acceleration

• Momentum

• Angular momentum

• Constraint force and torque

• Gravity, electrostatic and air force

• Kinetic energy, gravitational potential 
energy and power

Record and display simulation data in real-time
with graphical and digital meters.

SIMULATION CONTROL

Run, stop, reset, single step, or pause the 
simulation at any time.

Control the accuracy of your simulation by
modifying integration and animation steps 
and configuration tolerances.

Superimpose multiple simulations.

INTERACTIVE CONTROLS

• DDE connection to Excel and MatLab

• Complete “Visual Basic” style scripting 
language with built-in debugger 

• Menu and script buttons 

• “Player” mode for content creation

VISUALIZATION

• Track the motion path of a body or its 
center of mass 

• Attach graphics to bodies 

• Images on bodies rotate 

• Display system center of mass 

• Multiple, moving reference frames 

SCRIPTS

• Optimize 

• Create constraint 

• Document model 

• Zoom to extents 

• Measure distance between points 

• Flip polygon 

• Multiple file run 

• Pin friction 

• Slot friction 

• Slot damper 

• Flexbeam

• Shear and bending moment

OUTPUT

• AVI video files for playback

• Meter data from simulations to

tabular data file

PRINTING

• Print an image of your simulation or 

meter data

WORKING MODEL 2D
SYSTEM REQUIREMENTS

• Microsoft Windows NT® 4.0 or 

Windows 95/98/Me/2000/XP

• Pentium PC

• 16MB RAM Minimum

• Video card and monitor capable 

of at least 16-bit color

• CD-ROM Drive

www.workingmodel.com
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Welcome to Working Model 
 
Working Model is the result of a 15-year collaborative effort between professional engineers and software specialists.  We are 
committed to providing you easy-to-use, engineering software that makes you more productive, and saves time and money on 
hardware prototyping, testing, and virtual product development.  
 
To begin, install Working Model and go through each step of the demonstration described below.  
 
 

 
 
 
Installing Working Model 
 
1. Insert the Working Model CD into the CD-Rom drive and 
follow the installation instructions 
2. When prompted for a serial number, enter “DEMO” or enter 
your licensed serial number 
 

 
 

3. When the “Choose Folder” window appears, click [OK]. 
4. For a step-by-step introductory tutorial, turn to the next page. 
 

 

http://www.workingmodel.com 
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Starting Working Model 
1. Ensure that Working Model is installed on your computer.  
2. From the Windows  Menu, click on Programs, then Working Model, and 
then Working Model. This opens a simulation. 

 
1 Creating a Falling Block 
1. The first simulation is Newton’s first experiment, dropping a block.  
2. To draw a rectangle, click on the Rectangle tool, then click in the workspace and 
draw a long thin rectangular block.  
3. To run the simulation and see the block fall due to gravity, click . 
4. Click  to reset the simulation.  
 

 

 
2 Adding a Velocity Vector 
1. To add a velocity vector, click on the rectangle. 
2. From the Define menu, click on Vectors and then Velocity. 
3. Click  and observe that the vector changes magnitude as the block falls. 
4. Click .  
 
Optional: To show the velocity vector’s x and/or y component, click on the Define 
menu, select Vector Display, and check the X and/or Y box. 
 

3 Making a Pendulum 
1. To make a pendulum, click on the Pin joint tool and then click on the upper left-
hand corner of the rectangle.  
2. Click  and observe that the vector changes magnitude and direction as the 
pendulum moves. Click .  
 

 
 
Optional: Each click on  at the bottom of the screen advances one frame.  
 

4 Graphing the Pendulum’s Motion 
1. To graph the pendulum’s motion, click on the rectangle. Under the Measure 
menu, select Position, then select Rotation Graph.  
2. To collect data, click . Note: Data can be displayed as a graph, bar chart, 
or number, and can be changed while running the simulation by clicking the  on 
the top left-hand corner of the graph. Click . 
3. The graph shows the pendulum’s amplitude and frequency. To make the graph 
larger, click on the graph and drag its lower right-hand corner to the right. 
 

 
 
 

5 Changing Gravity 
1. To change gravity, click on the World menu, select Gravity, type the value 20 
m/sec2 in the input box, and click [OK]. 
2. Click  and observe that, in agreement with theoretical and experimental 
predictions, the pendulum has a higher natural frequency. Click . 
 

Note: Working Model was designed to be easy-to-use. For example, in this 
exercise, the only time you need to touch the keyboard is to enter the value 20. 

 

 
 
6 Adding Air Resistance 
1. Under the World menu, select Air Resistance, click on Low Speed, and accept 
the default air resistance value of 0.3 kg/(m*s) by clicking [OK]. 
2. Click  and observe the exponentially decaying oscillations. Click . 
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7 Adding a Spring 
1. To add a spring, click on the Spring tool. Click on the upper right-hand corner of 
the block and stretch the spring up and to the right. 
2. Click  and observe the pendulum's higher natural frequency and new 
equilibrium position. Click . 
 

 

 
8 Controlling the Spring Constant 
1. To control the spring constant, click on the spring. Under the Define menu, select 
New Control, then select Spring Constant.  
2. The slider that controls the spring will appear in the left-hand side of the 
workspace. To move the slider's location closer to the spring, click on its title and 
drag it next to the spring.  
3. To see the effect of varying the spring constant, click  and observe that the 
pendulum angle is a function of the spring-constant (move the slider up and down 
while the simulation is running). Click . 
 

 
 
Optional: The properties of any object can be modified by double-clicking on any object (e.g., the 
rectangle, pin point, graph, spring, spring-constant control). 
The appearance or geometry of an object can be modified by clicking on the object, selecting the 
Window menu and selecting Appearance or Geometry. 

9 Collisions with a Smooth Polygon 
1. To create a smooth polygon, click on the Curved Polygon tool, click in the 
workspace in a few locations. Double-click to close the polygon.  

(If your rectangle is high on the screen, click  to zoom to extents.) 
2. Click  to start the simulation and observe that the curved polygon bounces 
and rolls on top of the rectangle. Automatic collision and contact is a very useful 
feature in Working Model (even the elastic and frictional properties of objects may 
be varied). Click .  
 

Note: Collision sound/motion sound can be added to a simulation. To add a 
collision sound, click on the curved polygon, select the Measure menu, and 
choose Hear the Collision. (Windows only; computer speakers required) 

 

 
  
10 Smart Editor 
1. Working Model's Smart Editor allows the user to change an object's position and 
orientation while keeping constraints intact.  
2. To change the orientation of the rectangle, click on the rectangle and drag the 
mouse to rotate the rectangle counterclockwise so that it is nearly vertical as shown 

below. (If necessary, click  to view to extents.) 
 

11 Creating a Cam-Follower Mechanism 
1. To add a motor to the curved polygon, click on the Motor tool, and then click on 
the curved polygon.  
2. Click  and observe that the rectangle's motion is determined by the shape 
of the curved polygon and the motor's speed. Click . 
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12 Creating a Flexible Beam 
1. To convert the rectangle into a flexible beam (Flexbeam), click on the rectangle. 
2. Under the Script menu, select Flexbeam. 
3. In the “Flexible Body Information” dialog box, accept the default values and click 
[OK]. Click [OK] in the “No Flexbeam Undo” dialog Box. 
4. Click  to start the simulation and observe that the formerly rigid rectangle is 
now acting as a Flexbeam. Change the values of the “EI” and ‘Damping - Bending” 
sliders to change the Flexbeam’s stiffness and damping. Click . 
 

 
 

13 Animation Step and Integrator Error  
1. To change accuracy, select the World menu and then Accuracy…  
2. Select an Integrator Error small enough to meet your accuracy requirements.  
3. Select an Animation Step that produces smooth visual results. 
 

14 Importing DXF Files 
1. Open a new simulation by selecting the File menu and clicking on New.  
2. To import a DXF file, select the File menu and click on Import. 
3. In the Import window, navigate to the directory where Working Model is installed, 
for example, C:\Program Files\WorkingModel and then select the sub-directory 
WMIntroduction. 
4. Select the file WMDXFDemo.dxf and click [Import]. This imports the DXF objects 
(a crane, wrecking ball, a Working Model logo, and an abandoned building). 
5. Click  and watch all the objects fall due to gravity. Click . 
 

15 Simulating a Building Demolition 
1. To anchor the base of the building, click on the Rigid Joint tool, then click on the 
base of the building. 
2. To anchor the crane, click on the Rigid Joint tool, then click on the crane. 
3. To fix the Working Model logo to the crane, click on the Rigid Joint tool, then click 
on the Working Model logo. 
4. To attach the wrecking ball to the crane with a rope, click on the Rope tool, then 
single-click on the ball, and then single-click on the crane to create a rope. 
5. Click  and observe that Working Model detects the shape of the imported 
DXF objects and automatically calculates how they collide. Click . 
  

 
 

16 Adding Colors to DXF Objects 
1. Objects that are imported from a DXF file are treated the same as objects 
created within Working Model. You can change their appearance, measure their 
velocity, acceleration, etc.  
2. To add color to the crane, click on the crane. 
3. Under the Window menu, click on Appearance. 
4. In the Appearance window, note that the fill pattern is currently set as “no.” Click 
on the drop-down menu and change it to another pattern. 
5. Click on the fill color drop-down menu and change the fill color to blue. 
6. Close the Appearance window. 
7. To change the color of the other objects, repeat steps 2 to 6.  
8. Click  to start the simulation. Click . 
 

17 Running Demo Files 
1. Under the Script menu, click on “Run All Demo Files”. 
2. Sit back and enjoy a series of demos on a variety of engineering topics. 
 

 
 

18 Creating a Movie  
1. You can create a movie from any Working Model simulation.  
2. To see an example, select  menu, then Programs, then WorkingModel, 
then WMIntroduction, and then double-click on WorkingModelMoneyBowl.avi. 
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Working Model 2D Educational Pricing 
Price List – August 22, 2005 

Phone: 650-381-3395 or  800-766-6615      Fax: 650-574-7541 
http://www.workingmodel.com 

 
Working Model® 2D 2005 (Windows Only) Upgrade from version 5.0 or higher 
Description Item No. Price U.S.$ # of CDs # of manuals Item No. Price U.S.$  
Single User (Node-locked)* WM01NL $345 1  1  WM01NLUp $145 
Additional Single User* WM01 $150 1 0 WM01Up $70 
10 User WM10 $1985 1  1  WM10Up $835  
20 User WM20 $2985 1  1  WM20Up $1255  
30 User WM30 $3985 1  1 WM30Up $1675 
50 User  WM50  $5985  1  2  WM50Up $2485  
75 User  WM75 $8485  1  2 WM75Up $3565  
100 User  WM100 $9985  1  3  WM100Up $3985  
200 User  WM200  $15,985  1  4 WM200Up $6385  
Custom User  WMCustom  Call  Call  Call  WMCustomUp Call  
Homework9* WMHW  $600 10 0  Requires 10+ user license of current Working Model 
Extra manual  WMUSR  $60  0  1  Requires current Working Model license 
Spanish Manual  WMUSRSP  $60  0  1  Requires current Working Model license 
Ancillary  WMACL  Call  Call Call Ancillary Curriculum License for special development  
Training WMACL  Call  Call Call Educational and Professional Training 
Developer10  Call $2500  1  1  For textbook publishers and curriculum developers 
WM upgrades will be accepted with corresponding valid WM 5.0 serial number (no upgrades from WM4.x or earlier) 
Upgrade from Working Model version 3.0 with a 20% discount off the new price. 
WM upgrades ship with installation instructions and an introductory tutorial.  Information about new features is contained in the CD. 
* Single users and Homework users need to provide a machine ID to obtain a node-locked machine-specific installation serial number (not required for Network Licenses). 
 

1.  A copy of the school's purchase order and/or purchasing information must accompany all orders from the school ordering the software. 
2. Orders to US and Canada: American Express, Visa, MasterCard, Discover, checks, purchase orders accepted.  
3. International orders: American Express, Visa, MasterCard accepted. Bank wire transfers more than $2500 accepted. Shipping and handling of $35 is charged. 
4.  Sales tax is added unless a Federal Excise Exempt Certificate or Local Sales Use Tax Exempt Certificate is submitted with the purchase order 
5.  When possible, orders are shipped within 48 hours. 
6.  All sales are final.  If you are tentative about a purchase, ask for a demonstration copy. 
7. To trade up from  x users  to  y users  (with or without an upgrade), use the following price calculation formula: 
Trade-up price = (new y user price – new x user price)  +   x upgrade price (if applicable) 
Example: 10 user upgrade trade-up to a new 20 user:    ($2985 - $1985) +  $835 = $1835 
8. Resellers are required to fax the school purchase order when placing an order. 
9.  Homework/Student Editions do not include manuals or technical support and are only for student projects on student-owned computers (not for school 
computers). Homework/Student Edition licenses are valid for one year and are limited to 50 bodies, 15 constraints, and 15 output meters. 
10. Textbook Editions are licensed with a Developer version and are able to play simulations created by a developer (for publishers etc.) 
11. Technical support is provided by your software vendor, i.e., MSC.Software or your reseller for the first four months of new or upgrade purchases. 
12. Multi-user licenses are networkable 
13. †For version differences, please see  http://www.workingmodel.com/faqlist.html#Differences 
14. Students purchases must be accompanied with a valid student ID, proof of current enrollment in an engineering degree-granting program, and contact from the 
relevant engineering instructor to verify that the product will be used for educational use. 
15. Other than the Homework Edition (licensed for one year), the software is licensed for 4 years. 
16. Prices and terms are subject to change without notice. 

 
 




